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“CPCB” is free software: you can redistribute it and/or modify it under the terms
of the GNU General Public License as published by the Free Software Foundation,
either version 3 of the License, or (at your option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or FIT-
NESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for
more details.

You should have received a copy of the GNU General Public License along with
this program. If not, see http://www.gnu.org/licenses.
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Chapter 1

Introduction

This document describes the installation and usage of “CPCB,” a (hopefully) easy-to-
use program for designing printed circuit board (PCBs) written by Daniel Wagenaar.
A companion program, “CSchem,” is provided for designing circuits prior to instanti-
ating them on a PCB. This program is documented separately.

1.1 Why use CPCB?

There are any number of software packages and online options available that allow
you to design PCBs. So why should you choose CPCB? CPCB is for you if:

• You like a program that keeps simple tasks simple;

• You just want to make a few boards for a project and get on with your life;

• You like a what-you-see-is-what-you-get approach;

• You like to switch between imperial and metric units fluidly;

• You use CSchem for drawing circuits.

On the other hand, CPCB might not be for you if:

• You need to specify arcane properties on your electronic parts for automated
workflows;

• Your projects are so complex that you really need an autorouter;

• You need boards with internal layers.
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1.1.1 A note on development

CPCB is being developed by an active research scientist. Practically, that means two
things: On the positive side, it means that I have a vested interest in fixing bugs and
improving CPCB, because I use it regularly. On the negative side, that means that, by
and large, new features are added only when I need them and bugs are fixed when I
have time. I certainly do welcome feature requests, but I cannot guarantee that they
will get implemented quickly or at all. (If you are in a hurry, I will consider (paid)
consultancy related to CPCB.) Finally, I definitely welcome contributions to either the
code or the documentation. I would be very happy if CPCB turned into a community-
supported open source project.

1.2 Features

A document in CPCB consists of a single PCB that can be either rectangular or round.1

The PCB can be populated by traces, pads, holes, and text.2 These basic objects can
be placed on any of three layers: a bottom copper layer, a top copper layer, and a
top silkscreen layer. Most of the time, holes and pads on the copper layers will be
grouped together with some text and line segments on the silkscreen layer to form a
“component,” such as a connector, a resistor, or an IC socket.

Objects have various properties, such as line width, hole diameter, or pad size, and
these can be edited by means of a toolbar on the right of the main window. Objects
can be placed on the PCB, connected with traces, moved around, rotated, transferred
to other layers, etc., all with straightforward mouse interactions.

CPCB comes with a small library of predefined components, but creating your own
custom components is very easy thanks to a flexible system of coordinates and grids
and quick access to functions to label pins.

CPCB can be used stand-alone for small projects, but is a particularly strong tool
in combination with CSchem: If you “link” a CSchem schematic to a PCB layout,
CPCB will show a toolbar with all the components that you have not yet placed, and
will also highlight connections that are required to complete the circuit as designed.

CPCB can export its designs in Gerber format, which is the lingua franca that
most online PCB fabrication services understand.

1.3 Contacting the author

If you like CPCB or find fault with it, if you discover a bug or have a suggestion
for a new feature, if you are interested in improving this documentation or have a

1More complex outline shapes are planned for the future.
2There are two more basic objects, arcs and filled planes, which will be discussed in Chapter 3.
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patch to contribute to the code, I want to hear from you. My contact information is at
http://www.danielwagenaar.net. I very much look forward to hearing from you. I real-
ize that this guide is extremely terse, and I really do welcome questions, particularly
if they help me to improve CPCB or its documentation.

Pasadena, January 2019
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Chapter 2

Installation

The latest version of the software can always be downloaded from
http://www.danielwagenaar.net/cschem.

2.1 Precompiled binaries

Binary packages for Linux, Windows and Mac OS X will be provided as time permits.
You can help focus my attention on binaries simply by expressing an interest.

2.2 Compiling the source

To compile the source, start from the provided “cschem.tar.gz” archive or check out the
git source at http://github.com/wagenadl/cschem. Compilation requires “Qt” version
5.6 or later.

2.2.1 Compiling on Linux or Mac OS

You will need a C++ compiler and “make”. On Ubuntu Linux, this is as simple as
“sudo apt-get install g++ make”. On Mac OS, you need the “Command Line tools for
XCode” from the Apple Developers’ web site1.

Open a terminal and “cd” to the root of the unpacked source archive. Then type
“make” and fetch a cup of tea. Then, either manually copy the file “build/cpcb/cpcb to
some location on your PATH, or type “sudo make install” to install into “/usr/local/bin”.

2.2.2 Compiling on Windows

Details to follow. Again, feel free to ask!
1https://developer.apple.com/xcode.
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Chapter 3

Using CPCB

3.1 The graphical user interface

CPCB has a relatively spare user interface with several toolbars around the PCB
being edited. These toolbars are:

Mode bar CPCB makes heavy use of “editing modes.” At any time, CPCB is in one
of several modes, and a toolbar on the left of the main window is used to switch
between modes and to indicate the current mode.

Properties bar A toolbar on the right shows the various editable properties of se-
lected objects or objects to be placed.

Status bar A small bar at the bottom of the window shows cursor position, grid set-
tings, and which features are currently being shown.

Menu bar Along the top of the window a standard menu bar is shown.

One other panel is shown only when CPCB is used to edit a PCB design that is linked
to a CSchem schematic:

Components pane Here are shown all the not-yet-placed components. You can drag
component footprints from a Filer window1 into this pane, or from this pane onto
the main PCB.

3.1.1 Editing modes

CPCB uses different “modes” for placing, moving, and modifying holes, traces, and
other objects. Because changing modes is such a frequent task, keyboard shortcuts

1E.g., Gnome Files in Linux, the Finder in Mac OS, or the File Explorer in Windows.
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are available for each of the modes. The modes are (from top to bottom in the “mode
bar”):

Selection mode (F1) This is a highly multifunctional mode:

• Objects can be selected by clicking on them or dragging a rectangle over
them.

• Selected objects can be modified using the Properties bar.

• Objects can be moved by dragging with the mouse.

• Objects can be deleted or placed on a clipboard using standard cut-and-
paste operations.

• Selected objects can be grouped into a component (“Control”+“G”) and exist-
ing components can be ungrouped into separate objects (“Control”+“Shift”+“G”).

In addition, double-clicking on different types of objects has specific effects in
this mode:

• Double-clicking on a group “enters” the group so its contents can be edited
in-place. (Double-clicking on blank space “exits” a group that was entered
in this way.)

• Double-clicking on a pad or hole allows the name or number of that pad or
hole to be changed.1

• Double-clicking on a piece of text allows the text to be edited.

Trace mode (F2) In this mode, new traces are placed on the PCB by clicking with
the mouse. The Properties bar can be used to determine the width of the traces
as well as which layer they will be placed on. Traces can be placed on copper
and silkscreen layers alike.

Plated hole mode (F3) In this mode, mouse clicks place plated holes on the board.
Holes always connect the top and bottom layers of the PCB. The Properties bar
can be used to determine the hole diameter and the diameter of the surrounding
pad. Holes can have either round or rectangular pads. Instead of a simple drill
hole, straight milled slots can be placed in this mode as well; the slot length
is determined on the Properties bar. Usually, holes are part of components, in
which case the “Pin” box in the Properties bar shows the pin name or number
for the hole. This mode should not be used to create vias; see below.

1When a pad or hole is part of a component that is linked to an element on a CSchem schematic, a
combobox with predefined choices appears; otherwise, a free-form name editor appears.

8



Pad mode (F4) In this mode, copper pads are placed on the PCB. Pads are generally
used as part of surface-mount components, in which case the “Pin” box in the
Properties bar shows the pin name or number for the pad. Pads are normally
placed only on copper layers, but CPCB doesn’t stop you if you want to place a
pad on the silkscreen layer.

Text mode (F5) In this mode, clicking on the board opens a small dialog window in
which you type the text to be placed. Text is normally placed on the silkscreen
layer, but may be placed on copper layers as well.

Arc mode (F6) In this mode, circles or arcs are placed, typically on the silkscreen
mode as part of component outline drawings.

Filled plane mode (F7) Filled planes are filled areas on either copper layer. In filled
plane mode, new planes can be created, existing planes can be edited, and holes
and pads can be connected or disconnected from filled planes by double clicking.
Use the Layer selector in the Properties bar (not the Layer visibility toggles in
the status bar) to determine the layer for a filled plane or filled plane connection.

Pickup mode (F8) In this mode, clicking on an existing trace picks up that trace so
that you can conveniently reconnect it to another point on the PCB.

Nonplated hole mode (F9) Nonplated holes are holes without copper plating. This
mode can also be used to create straight milled slots.

Board outline mode (F10) In future versions, this mode will allow editing of the
board outline in arbitrary shapes, but at present this is not yet implemented.

The Mode bar contains two additional buttons that do not correspond to editing modes:

Origin selection (F11) When CPCB first starts, it uses absolute coordinates with
(0,0) at the top-left of the board. Press F11 switches to incremental coordinates
and invites the user to click on a hole or pad to set the origin for incremental co-
ordinates. After an incremental origin is selected, CPCB automatically reverts
to Selection mode. To return to absolute coordinates, press F11 again. (When
entering incremental coordinate mode, you don’t have to pick a new origin; just
press F1 to return to Selection mode with the previous incremental origin rein-
stated.)

Angle constraint (F12) Use this to toggle between placing traces with arbitrary an-
gles and placing traces that are constrained to be either horizontal, vertical, or
at 45◦ to the canonical axes.
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3.1.2 The Properties bar

The properties bar is used to specify properties for new items to be placed on the board.
In “Edit mode,” the properties bar reflects the properties of currently selected items,
and can be used to modify those properties.1 Although most items in the Properties
bar may speak for themselves, here is a list with a few notes. From top to bottom:

X Shows the x-coordinate of the center of a hole, pad, or arc, or the left edge of a piece
of text. When multiple objects are selected, the leftmost x-coordinate is shown.2

You can type in the box to move the selection to a new location.

Y The y-coordinate equivalent of previous item. When multiple objects are selected,
the topmost y-coordinate is shown.

Line width This item represents the width of traces and arcs.

Diameter The diameter of (plated and nonplated) holes as well as arcs.

Slot length The extra length of a milled slot. (The full length of a slot is the stated
“Slot length” plus the diameter.) Meaningful for plated and nonplated holes.

OD Outer diameter of the round pad surrounding a plated hole, or length of the
square pad surrounding such a hole. If the hole is in fact a slot, the pad is
expanded along with the hole.

Shape Selects whether the pad surrounding a hole is round or rectangular.3

W The width of an SMT pad (along the x-axis).

H The height of an SMT pad (along the y-axis).

Ref. or Pin or Text Multifunctional item that shows the “Reference” ID for a compo-
nent; the “Pin number” for a hole or pad; or the contents of a text object.

Fs Font size for text objects.

Arc style Selector for different kinds of arcs.
1When multiple items are selected and they have conflicting property values, the properties bar will

show “–––” instead of an actual value. Even in that case, typing in a new value overrides the properties
of all applicable selected objects.

2At present, this is true even when those objects are contained in a group. In a future version, the
x-coordinate of a group may be defined as the x-coordinate of its lowest numbered pin.

3“Rectangular” really means “square” except if the hole has nonzero slot length.
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Wherever dimensions appear in the Properties bar, simple arithmetic is accepted.
Thus you can type things like “0.3 in + 2*0.7 cm”. CPCB understands “mm” and
“cm” as metric units. It also understands “in,” “inch”, and “"” (double quote) to mean
inches. If you leave out a unit, the units of the current grid determine how your input
is interpreted.

At the very bottom of the Properties bar, there are two more rows of buttons: The
first allows rotating and flipping of selected objects in Select mode. It doubles to
determine the orientation of newly created objects in Text and Arc modes. The second
row determines on what layer newly created objects appear and can also be used to
move objects between layers.

3.1.3 The Status bar

The status bar displays the coordinates of the cursor and shows the identity of holes,
pads, and components that you hover over. It is also home to a popup menu for select-
ing grid spacing. (Several common choices prepopulate the menu, and you can define
your own custom grid spacing in either inches or millimeters simply by typing in any
line.)

A group of icons on the right of the Status bar serves as indicators and toggles for
visibility of (from left to right): the silkscreen layer; the top copper layer; the bottom
copper layer; filled planes; and nets. The last two deserve further explanation:

• Filled planes may be placed on either top or bottom copper layers. They are only
visible when both the layer on which they occur is visible, and the “filled planes
visibility” toggle is on.

• “Nets” are collections of traces, holes, and pads that are electrically connected.
When nets are visible, these collections are highlighted when the mouse hov-
ers over any of their members. Additionally, if your PCB design is linked to a
CSchem schematic, holes or pads that should be part of a net (but aren’t yet) are
highlighted in blue, and holes or pads that should not be part of a net (but are)
are highlighted in pink. The message area on the left of the status bar may also
show pertinent information about nets.

3.1.4 Components pane

When a PCB layout is linked to a CSchem schematic, one additional user interface
component is shown alongside the PCB: A list of all the components of the schematic
that have not yet been placed on the PCB. The function of this pane is explained in
section 3.2.4.
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3.2 Working with components

CPCB ships with a small library of predefined components and it is very easy to add
your own to the library.

3.2.1 Placing library components onto a PCB

Press “Control”+“Shift”+“O” to show the library (or select “Open library” from the
Tools menu). CPCB components are saved as SVG files, so in some operating systems
the Filer window will show previews. Components may be placed on the PCB simply
by dragging them in from a Filer window. Please note that CPCB cannot handle
arbitrary SVG files, only the special SVG files that it creates itself, so do not draw
components in an external SVG editor and expect CPCB to import them into your
layout.

3.2.2 Creating new components

To create a new component from scratch, simply place holes, pads, and outlines onto
a PCB. It may be helpful to use “incremental” coordinates to place features of the
component relative to each other. Be sure to assign pin numbers to all holes and pads.
When done, use “Control”+“G” or the menu to group the features together. A default
“reference” text will appear, which you could edit. For instance, if you drew a new
symbol for a diode, you might want to replace the “X?” with “D?”. To save a copy of
the component for use in future layouts, press “Control”+“Shift”+“I” or select “Save
component. . . ” from the “Tools” menu.

3.2.3 Editing components

To edit a component, the easiest thing to do is to double click on its outline on the
board. This will “enter the group” of the component, hiding all PCB elements that
are not part of the component. You can now add, remove, or modify elements of the
component at will. Double click on the background to “leave” the group. At this point
you may want to press “Control”+“Shift”+“I” (or select “Save component. . . ” from the
“Tools” menu) to save the component, either replacing the old version if you are simply
fixing a mistake, or as a copy if you are creating a new component based on an older
one.

If all you need to do is renumber some pins of a component, it is even easier to just
double click on those pins and type the new numbers in the popup box.
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3.2.4 Using the components pane

The components pane serves as a placeholder for components that are part of a linked
schematic but that have not yet been placed on the PCB. On first use, it simply shows a
list of those components, identified by their “Reference” text, their “part/value” text (if
defined) and their number of pins. If you have used a similar component before, CPCB
may display a default outline package instead. The following actions are available in
the components pane:

• You can drag a component outline from the pane to the PCB.

• You can drag a component outline from a Filer window to the pane.

• You can drag a component outline from one tile in the pane to another to conve-
niently apply the same outline to multiple components.

• You can rotate or flip an outline by pressing “R”, “Shift”+“R”, or “F” after clicking
it.

• You can copy a component outline from the PCB into the pane by selecting (only)
that component on the PCB and clicking on the target tile with the middle mouse
button or with “Control” and the left mouse button.

Instead of dragging component outlines directly onto the PCB from a Filer window, it
is sometimes convenient to first drag them onto the “components pane,” copy them to
all like items, and then drag those onto the PCB.

3.3 Working with filled planes

Filled planes are a convenient way to distribute ground or power connections to dif-
ferent parts of a PCB. A ground plane can also serve an important role in protecting
your circuit from electromagnetic interference.

3.3.1 Placing a filled plane

Filled planes are placed in “Filled plane mode” simply by dragging out a rectangle
starting from an empty location on the PCB.

3.3.2 Editing a filled plane

In “Filled plane mode,” you can move the corner points of a filled plane around by
dragging with the mouse. You can insert corners along any edge simply by drag-
ging the marker that automatically appears when you hover near an edge. You can
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remove a corner by pressing “Delete” when it is highlighted. If you press and hold
“Shift” and then hover the mouse over an edge, an edge marker rather than a corner
marker appears. This is a convenient way to move the edge as a whole. A potentially
nonintuitive (but very helpful) behavior is that perfectly horizontal edges can only be
dragged in the vertical direction and vice versa, whereas edges that are not parallel
to a principal axis can be dragged in any direction.

3.3.3 Deleting a filled plane

In “Filled plane mode,” you can delete a filled plane simply by pressing “Delete” while
hovering over its interior. In “Edit mode” you can delete a filled plane by first selecting
it and then pressing “Delete.”

3.3.4 Moving a filled plane

Move a filled plane in its entirety is done in “Edit mode” rather than in “Filled plane
mode,” simply by selecting it and dragging it to a new location.

3.3.5 Making and breaking connections to a filled plane

In “Filled plane mode,” connections between pads and filled planes can be created and
removed by double clicking on the pad. Likewise, connections can be made between
plated holes and filled planes. Use the “Layer” buttons at the bottom of the “Proper-
ties bar” to choose whether a connection is made in the top or bottom copper layer.
Note that plated holes can only connect to one filled plane. This is to prevent a mis-
take I have made too many times in other PCB layout programs, where I meant to
move a filled plane connection from the bottom layer to the top layer but accidentally
preserved the connection in the bottom layer as well. (Because these connections lie
perfectly on top of one another, the bottom layer connection is easily overlooked.) If
you absolutely must connect two filled planes using a single hole, you can create two
separate holes first and drag them on top of each other. (But don’t tell anyone I said
that.)

3.4 Exporting for fabrication

The purpose of a PCB layout program is to allow you to make PCBs. CPCB can
therefore export your design to the industry-standard “Gerber” file format.1 To export
a Gerber file, press “Control”+“E” or choose “Export Gerber” from the “File” menu.

1For those new to this business, it may be worth knowing that a “Gerber file” is actually a whole set
of files, typically packaged together in a “zip” archive. Each layer of the PCB layout is represented as a
distinct file in the archive. Additional files represent the locations of through holes.
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Gerber files can be uploaded to a variety of fabricators on the internet. A useful
website to compare offers from many sources is https://pcbshopper.com. Pro tip: Be
sure to select lead-free surface finish as well as lead-free solder. Don’t poison youself.

Most fabricators have a way to verify that their interpretation of the file you up-
loaded matches your intentions. Please use those tools, and note that by using CPCB,
you accept the terms of the GNU General Public License. That means, among other
things, that the author cannot accept any liability for incorrect fabrication,
even if CPCB exported patently incorrect Gerber files.

3.4.1 Exporting solder paste masks

If your layout involves any surface-mount components, you may wish to produce a
solder paste mask. To export a paste mask, press “Control”+“Shift”+“E” or choose
“Export paste mask” from the File menu. After specifying a file name, you will be
asked to specify the desired “shrinkage for cutouts.” This number can be used to
make the holes slightly smaller than the solderable area, to compensate for the kerf
of a laser cutter.

3.4.2 My procedure for SMT soldering

It turns out that it is quite easy to make solder masks on a laser cutter, and low-
temperature lead-free solder paste practically eliminates the risk of overheating com-
ponents. Here is what I do:

1. Design your layout and have your board manufactured. Do yourself and the
environment a favor and pay the little extra for a lead-free finish.

2. Export the paste mask as an svg file with 0.005” (0.125 mm) shrinkage. This file
can be loaded into Corel Draw for laser cutting.

3. Cut the paste mask out of overhead transparency. I use Apollo Laser Printer
Transparency Film (#VCG7060E) placed on top of a sheet of aluminum. The
film is 0.002” (0.050 mm) thick; the thickness of the aluminum is not important.
Cut the outlines of the pads in vector mode. On my 75-W ULS laser cutter, I use
25% power, 100% speed for the pads, cutting three times. Then I cut the board
outline with 65% power, 100% speed, once. This gives a nice flat surface on the
back with slight ridges on the front. Check for hanging chads.

4. Tape the mask to the board. I use packing tape, but it is not critical. Use a stere-
omicroscope or a magnifier to ensure precise alignment. (A pair of +2.00 to +2.50
reading glasses makes for a remarkably effective head-mounted magnifier.)
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5. Squeeze solder paste into the pads. The paste I have been using is Sn 42%/Bi
57%/Ag 1%, melting point 137 ◦C. It is described as “No-clean flux, 87% metal
(20–38 microns).” The package expires in 12 months, so don’t buy too much at
once. I squeeze it out of the syringe onto one side of the layout, then use a metal
spatula or a plastic ruler to distribute it into the holes.

6. Remove the mask. This has to be done very carefully so as not to smudge the
pads.

7. Preheat the board. I have a really cheap reflow workstation. The thermostat
of the IR preheater is broken. No matter, use a thermometer to check that the
temperature at the location of your board is around 100 ◦C. Preheating a PCB
takes 2–3 minutes. Don’t worry about overheating: 100 ◦C is a profoundly safe
temperature for all electronic components I’ve ever worked with. (Some plastic
LED lenses may get a little soft, but they don’t actually melt.)

8. Melt the solder. My reflow workstation comes with a mini heat gun. I set it to
175 ◦C and melt all the solder by moving the heat gun slowly over the board. You
can see the paste turn shiny. Components may shift a little at this time; usually
they settle very nicely to center over their pads.

9. Cool the board. Remove the board from the heat using a pair of pliers (it’s hot!)
and watch the solder solidify under the dissection scope.

10. Clean up. It is very important to clean the metal spatula (and the mask if you
plan to use it again).

3.4.2.1 A note on temperature

It might seem that 137 ◦C is a crazy low melting point, but it is actually not unreason-
able: For instance, the max. operating temperature of Luxeon LEDs is 135 ◦C. Thus,
the solder should never melt under normal operating conditions.

3.4.2.2 Notes on solder types

Most solder formulations melt at a much higher temperature than the one I use, which
makes it much more difficult to avoid damage to electronic components: Old fashioned
leadead solder melts around 183 ◦C and other lead-free formulations tend to melt at
an even higher temperature. For reference, here are some common formulations. All
of the information in this section was taken from https://en.wikipedia.org/wiki/Solder.
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The formulation I use:

• Sn42/Bi57/Ag1: Melts at 137–139 ◦C. Patented by Motorola. Wiki says “Good
thermal fatigue performance.”

Other lead-free formulations:

• The tin-silver-copper (Sn-Ag-Cu or “SAC”) family. These typically have 3–4%
silver, 0.5–0.7% copper, lots of tin, and have melting points around 217–220 ◦C.
That requires pretty high soldering temperatures, which is obviously a chal-
lenge in a relatively poorly controlled environment. Sn-Ag-Cu-Mn formulations
have a slightly lower melting point (211–215 ◦C) but still well above Sn-Pb (next
section).

• In97/Ag3: Melts at 143 ◦C. Used for cryogenic applications and photonic devices.

• In100 (or In99): Melts at 157 ◦C. Used in low-temperature physics and for sol-
dering gold. Bonds to aluminum.

• Sn88/In8.0/Ag3.5/Bi0.5: Melts at 197–208 ◦C, closer to the Sn/Pb types. Patented
by Panasonic.

Leaded solder types:

• 60/40 Sn/Pb, which melts around 188 ◦C, and

• 63/37 Sn-Pb which melts at exactly 183 ◦C, the lowest of all tin-lead allows.

Of course, you don’t want to use these unless you have a really good reason.
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